


Intermec Technologies Corporation 

Corporate Headquarters 
6001 36th Ave. W. 
Everett, WA  98203 
U.S.A. 

www.intermec.com

 

The information contained herein is proprietary and is provided 
solely for the purpose of allowing customers to operate and 
service Intermec-manufactured equipment and is not to be 
released, reproduced, or used for any other purpose without 
written permission of Intermec. 

Information and specifications contained in this document are 
subject to change without prior notice and do not represent a 
commitment on the part of Intermec Technologies Corporation. 

© 2004 by Intermec Technologies Corporation. All rights 
reserved. 

The word Intermec, the Intermec logo, Norand, ArciTech, 
CrossBar, Data Collection Browser, dcBrowser, Duratherm, 
EasyCoder, EasyLAN, Enterprise Wireless LAN, EZBuilder, 
Fingerprint, i-gistics, INCA (under license), InterDriver, 
Intermec Printer Network Manager, IRL, JANUS, LabelShop, 
Mobile Framework, MobileLAN, Nor*Ware, Pen*Key, 
Precision Print, PrintSet, RoutePower, TE 2000, Trakker 
Antares, UAP, Universal Access Point, and Virtual Wedge are 
either trademarks or registered trademarks of Intermec 
Technologies Corporation. 

Throughout this manual, trademarked names may be used. 
Rather than put a trademark (™ or ®) symbol in every 
occurrence of a trademarked name, we state that we are using 
the names only in an editorial fashion, and to the benefit of the 
trademark owner, with no intention of infringement. 

There are U.S. and foreign patents pending. 

Microsoft, Windows, and the Windows logo are registered 
trademarks of Microsoft Corporation in the United States 
and/or other countries.  

 

ii Online Verifier Kit Installation Guide 

http://www.intermec.com/


 

Document Change Record 
This page records changes to this document. The document was 
originally released as version 001. 

Version Date Description of Change 

002 6/2004 Added ferrites to the printer/power cable 
illustrations and made minor updates to 
styles and content. 
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Introducing the Online Verifier (OLV) 
The RJS™ SV100™ Online Verifier (OLV) analyzes bar code 
print quality and detects print quality failures as your EasyCoder 
3400e, 4420, or 4440 printer prints labels. The OLV can be 
configured to grade bar codes at a user-specified ANSI level. 
With the OLV, you can make sure that your printers are 
operating at specified levels.  

Contact your local Intermec Sales Representative for availability 
of the OLV for the 3400e printer. 

 

Before you apply power to the online verifier, you 
must read the laser safety information in the  
SV Series Scanner/Verifier Operator’s Guide.  
A copy of this guide is included in the shipping 
box from RJS. 

Avertissement: Avant de mettre sous tension le 
vérificateur en ligne, vous devez lire les 
informations relatives à la sécurité laser contenues 
dans le guide SV Series Scanner/Verifier 
Operator's Guide. Une copie de ce guide est 
incluse dans la boîte d'expédition de RJS. 

Unpacking the Online Verifier Kit 
When you order the OLV kit, you receive a shipping box from 
RJS and a shipping box from Intermec. The contents of the two 
boxes are shown next.  

 

Note: If you order a new printer with the online 
verifier option, you receive a second shipping box from 
Intermec, which contains the printer. 

Make sure you have all of these parts. Contact your Intermec 
representative if anything is missing or damaged. 
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Contents of the Shipping Box Sent From RJS 

Parts supplied by RJS include: 

① SV100 Online Verifier (OLV) 

② Calibration bar code in a plastic sleeve 

③ RJS CD containing ScanVision software and a PDF copy of 
the ScanVision User’s Manual 

④ SV Series Scanner/Verifier Operator’s Guide (P/N 002-7942 E) 
and a compliance document 

Online 
Verifier
Kit

Installation Guide

21

5 6 7

3

 4 

98
11

10

 
Contents of the Shipping Box Sent From Intermec 
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Parts supplied by Intermec include: 

① Horizontal base 

② Vertical arm  

③ RAM mount (double socket arm and two rubber balls) 

④ Combined printer/power cable (P/N 072915) to connect the 
verifier to both the printer and the power source 

⑤ New bezel and plate for media cover 

⑥ Ladder Direction Bar Code Alignment Guide (P/N 073978) 

⑦ Picket Fence Direction Bar Code Alignment Guide  
(P/N 073978) 

⑧ This installation guide 

⑨ SV100 Online Verifier Kit CD (P/N 073992) containing the 
printer firmware upgrade files, the configuration file, PrintSet 
2.51 (or later), and a PDF copy of this installation guide 

⑩ Hardware package containing these parts: 

Quantity Description 

2 6-32 by 1/2 inch long flathead Phillips screws 

2 10-32 by 1/2 inch long flathead Phillips screws 

3 10-32 by 5/8 inch long pan-head Phillips screws 

2 10-32 by 3/4 inch long pan-head Phillips screws 
with captive lock washers 

2 10-32 nuts with nylon inserts 

3 10-32 nuts with captive lock washers 

8 Small adhesive cable mounts 

  

⑪ Verifier port kit (P/N 074010) containing these parts: 

Quantity Description 

1 Verifier adapter cable 

1 Connector plate 

2 Screws 

1 Warning sheet: Do NOT open this package. 
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Planning the Installation 
Make sure you have the cables and tools listed below. Also, you 
may need to discard or set aside some of the parts in the online 
verifier kit, depending on how you ordered the OLV. 

If you ordered a new printer with the online verifier option: 

• Discard the cutter port kit (P/N 074010). These parts have 
already been installed in your printer. 

• Make sure you have a 9-pin to 9-pin serial cable to connect 
the verifier to a PC. (If you order this item from Intermec, 
ask for P/N 059167.) 

• Make sure you have a 3/8 inch nut driver or socket and a 
number two Phillips screwdriver with a shaft at least 12.7 cm 
(5 in) long. 

If you ordered an OLV kit to install on an existing printer: 

• Contact your Intermec representative to arrange for a 
qualified service technician to install the verifier port. 

 

A trained Intermec service technician must 
install the verifier port. If you open the 
electronics cover, you will void the warranty 
and may cause damage to the internal 
components. Opening the electronics cover 
exposes the user to shock hazards which may 
result in injury or death. 

Avertissement: Le vérificateur doit être installé 
par un agent de maintenance Intermec qualifié. 
L’ouverture du couvercle du boîtier des 
composants électroniques entraînera 
l’annulation de la garantie, et peut endommager 
les composants internes. L’ouverture du 
couvercle du boîtier des composants 
électroniques expose l’utilisateur à des risques 
d’électrocution qui peuvent résulter par des 
blessures ou la mort. 

• Set aside the verifier port kit (P/N 074010) for use by the 
Intermec service technician. Do NOT open this package. 
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• Make sure you have a 9-pin to 9-pin serial cable to connect 
the verifier to a PC. (If you order this item from Intermec, 
ask for P/N 059167.) 

• Make sure you have a 9-pin to 25-pin null modem cable to 
upgrade the printer firmware. (If you order this item from 
Intermec, ask for P/N 048693.) 

• Make sure you have a 3/8-inch nut driver or socket and a 
number two Phillips screwdriver with a shaft at least 12.7 cm 
(5 in) long. 

 

Note: If your printer already has a cutter installed, be 
aware that you cannot use both a cutter and the 
OLV at the same time. Remove the cutter and use 
the existing cutter port for the OLV. Contact your 
Intermec representative to arrange for a qualified 
service technician to install the internal verifier 
adapter cable that is part of the verifier port kit (P/N 
074010). 

Installing the New OLV Hardware 
Follow these steps to install the new online verifier hardware: 

• Remove the media cover. 

• Attach the OLV to the printer and PC. 

• Modify the media cover. 

• Familiarize yourself with the OLV back panel. 

Removing the Media Cover 
Your first step is to remove the media cover from the printer. 

To remove the media cover 

1 Place the fingers of your right hand under the embossed 
section of the media cover (the media cover release). Pull the 
bottom of the media cover away from the base of the printer. 

2 Grasp the bezel on the front of the media cover with your left 
hand and lift the front of the media cover upward to release it 
from the printer frame. 
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If you ordered a new printer with the online verifier option, 
there is no bezel. Grasp the front edge of the media cover 
with your left hand. 

3 Lift the media cover away from the top of the printer. 

 

Feed/Pause

Power/Data
Alert

Empty/Pause

Intermec
Intermec4420

 

Attaching the OLV to the Printer and PC 
Follow these steps to install the mounting kit and OLV onto the 
printer, and to connect the OLV to your PC. 

To attach the OLV 

1 Place the 15-pin connector of the combined printer/power 
cable on top of the printer, as shown in the next illustration. 
Route the printer cable into the media opening of the printer. 
Route the power cable down the side of the printer. 
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Printer 
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Media Access Door: This printer is shown with the media access door 
removed. If the media access door is still installed on your printer, you 
may remove it or leave it open and route the cable above it. 

2 Attach the horizontal base to the front of the printer using 
two 10-32 by 1/2 inch long flathead Phillips screws. 

 

Note: Make sure the horizontal base does not pinch 
the two cables. The printer cable fits into the channel 
cut into the horizontal base. The power cable fits in 
the gap between the horizontal base and the side of 
the printer. 
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3 Attach the vertical arm to the horizontal base using two  

10-32 by 3/4 inch pan-head Phillips screws with captive lock 
washers and two nuts with nylon inserts. 
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Printer 
cable

Pan-head screw
with captive
lock washer
(2 places)

Nut with 
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Note: The horizontal base includes two slots for the 
screws. To determine where along the slot to attach 
the screws, consider the size and location of the bar 
code to be scanned as it exits the printer: 
• To print picket fence bar codes (defined on page 34), 

mount the vertical arm so the edge lines up with the 
edge of the horizontal base (shown on page 14).  

• To print ladder bar codes (defined on page 35), the 
placement of the vertical arm depends on the 
location of the bar code on the label. 

4 Use the nut driver or socket to tighten the two nuts with nylon 
inserts. Be sure the nuts are tightened completely so the vertical 
arm cannot move. Later, when you adjust the position of the 
OLV, you may need to move the vertical arm. 

5 Loosen the T-knob on the RAM mount and 
remove the two rubber balls from the double 
socket arm. 

6 Attach one rubber ball to the vertical arm using 
three 10-32 by 5/8 inch pan-head Phillips 
screws and three nuts with captive lock washers. 

T-knob
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Large adhesive
cable mounts
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7 Attach the two large adhesive cable ties to the vertical arm, 
exactly as shown in the previous illustration. 

8 Pinch the end of the double socket arm that contains the 
spring. Insert the open end of the double socket arm over the 
rubber ball you attached to the vertical arm. When you 
release the spring, the double socket arm remains attached to 
the ball. 

 

Double
socket
arm

Spring

Rubber
ball

Feed/Pause

Power/Data
Alert

Empty/Pause

Intermec
Intermec4420

Printer 
cable

T-knob

 

 

Note: The T-knob should point about 30° from 
vertical, not straight up. 
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9 Attach the remaining 
rubber ball to the OLV 
using two 6-32 by 1/2 
inch flathead Phillips 
screws. 

Make sure you orient 
the rubber ball as shown 
in this illustration.  

Flathead
screw
(2 places)

10 Taking care to hold the OLV firmly, insert the OLV/ball 
assembly into the double socket arm and tighten the T-knob 
until the OLV is firmly supported by the double socket arm. 

Feed/Pause

Power/Data
Alert

Empty/Pause

Intermec
Intermec4420

Printer 
cable

OLV

Rubber
ball

T-knob

Screw
(2 places)

 

 

To prevent equipment damage, do not release the 
online verifier until you are sure that the double 
socket arm holds the online verifier securely in 
place. 

Attention: Afin de prévenir tout endommagement 
de l’équipement, ne relâchez le vérificateur en ligne 
que lorsque vous êtes certain que le bras à double 
douilles maintient ce dernier solidement en place. 
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Note: Make sure that you orient the OLV/ball 
assembly as shown in the previous illustration, with 
the laser exit window facing down and the 15-pin I/O 
port close to the vertical arm. Later in the installation, 
you will use an alignment guide, ScanVision, and the 
calibration bar code to finalize the position of the 
OLV. 

11 Insert the combined printer/power cable connector into the 
15-pin I/O port on the OLV.  

12 Insert the printer cable into the cutter port at the base of the 
inside wall of the printer. 

If there is no cutter port, you need to arrange for an Intermec 
service technician to install the port. For help, see page 10. 

13 Secure both cables to the horizontal arm with the large 
adhesive cable ties. 

14 Attach the two small adhesive cable ties to the inside wall of 
the printer. Secure the printer cable with the ties so that any 
loose cable is looped along the bottom of the printer, where it 
cannot interfere with printer operation. 

Small adhesive
cable mounts 
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15 Attach one end of the serial communications cable (P/N 
059167) to the 9-pin serial connector on the OLV. Attach 
the other end of the cable to the serial connector on your PC. 

 

Before you apply power to the online verifier, 
you must read the laser safety information in the 
SV Series Scanner/Verifier Operator’s Guide.  
A copy of this guide is included in the shipping 
box from RJS. 

Avertissement: Avant de mettre sous tension le 
vérificateur en ligne, vous devez lire les 
informations relatives à la sécurité laser 
contenues dans le guide SV Series 
Scanner/Verifier Operator's Guide. Une copie de 
ce guide est incluse dans la boîte d'expédition de 
RJS. 

16 Route the power cable down the front of the printer as shown 
in the next illustration. 

 

Power
cable
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17 Attach the four cable mounts to the side of the printer with 
the cable clip facing down. Route the power cord along the 
side of the printer and secure it in the clips. 

Cable 
mounts
(4 places)

Power
cable

 
18 Plug the power end of the combined printer/power cable into 

a surge protector or power outlet. 

Modifying the Media Cover 
Follow these steps to install the new bezel and plate onto the 
media cover, but do not replace the media cover onto the printer 
until later. 

To install the new bezel and plate onto the media cover 

1 Loosen the three screws and washers that attach the existing 
bezel to the media cover. 

 

Note: If you ordered a new printer with the online 
verifier option, there is no bezel to remove. Loosen 
the three screws on the media cover and skip ahead 
to Step 3. 
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2 Remove the existing bezel. 

3 Place the media cover upside down on your work surface. 

4 Align the edges of the slots on the plate with the edges of the 
slots in the new bezel.  

 

Plate

Edges of plate
and new bezel
must line up 
as shown  

New 
bezel

 
5 Attach both plate and bezel to the media cover with the three 

screws and washers you loosened in Step 1. 

 

Plate

New 
bezel

Media cover 
shown upside
down  
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6 Set the media cover aside. Do not replace the media cover 
onto the printer at this time. 

Familiarizing Yourself With the OLV Back Panel 

I/O COMM

POWER SYNC

CALIBRATION

READ
RESET

1

2

 
OLV Back Panel: Use this illustration and the next table to identify the 
components of the OLV back panel. 

Identifying the OLV Back Panel Components 

Component Description 

I/O connector Connects the OLV to the printer and power. 

COMM 
connector 

Connects the OLV to the serial port of a PC. 

Power/Sync LED This LED is green when the OLV is receiving power 
and is yellow when triggered. 

Calibration LED This LED blinks yellow when the OLV is being 
calibrated. 

Read LED This green LED turns on when the OLV is decoding a 
bar code. 

LED 1 This green LED turns on when an ANSI, contrast, or 
quiet zone failure occurs. 

LED 2 This green LED turns on when the OLV partially reads 
or does not read a bar code. 

Reset button To turn off the laser beam, press and hold the Reset 
button until the beam turns off.  

To turn on the laser beam, press and release the Reset 
button. 

  

22 Online Verifier Kit Installation Guide  



 

Installing and Configuring the Software 
You need to perform several software and configuration tasks: 

• Install PrintSet. 

• Upgrade the printer firmware. 

• Choose Reprint Mode or No Reprint Mode. 

• Configure Reprint Mode or No Reprint Mode. 

• Install ScanVision. 

• Send the configuration file to the OLV. 

These tasks are described in detail in the next sections. 

Installing PrintSet 
You need PrintSet for various tasks associated with installing and 
using the online verifier. You can install PrintSet from the 
SV100 Online Verifier Kit CD or from the Intermec web site. 

 

Note: If you already have a copy of PrintSet, make sure 
you are using at least PrintSet version 2.51. Run 
PrintSet and click Help > About to display the 
version. If you have an older copy of PrintSet, uninstall 
it by opening the Control Panel and double-clicking 
the Add/Remove Programs icon. Select Intermec 
PrintSet and click the Change/Remove button. 

To copy PrintSet from the SV100 Online Verifier Kit CD 

1 Insert the SV100 Online Verifier Kit CD into the CD drive 
of your PC. The SV100 Online Verifier Kit window appears. 

2 Select Software and double click PrintSet 2.51 (or later) to 
start the installation wizard. 

3 Follow all the prompts to install the software. 

To download PrintSet from the web 

1 Go to the Intermec website at http://www.intermec.com. 

2 Select Service & Support > Downloads.  
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3 Choose your printer (such as Printers: EasyCoder 4440) 
from the drop-down menu. 

4 Double-click PrintSet ver. 2.51 (or later) from the table that 
appears.  

5 Follow all the prompts to download the software. 

Upgrading the Printer Firmware 
If you ordered the online verifier kit for an existing printer, you 
need to upgrade the printer firmware using PrintSet. 

 

Note: If you ordered a new printer with the online 
verifier option, you do not need to upgrade the printer 
firmware. Skip ahead to “Choosing Reprint Mode or 
No Reprint Mode” on page 26. 

You need these items to upgrade the firmware: 

• Null modem cable (P/N 048693) 

• SV100 Online Verifier Kit CD, which contains the two 
firmware upgrade files 

• PrintSet version 2.51 (or later) installed onto your PC, as 
described in the previous section 

To upgrade the printer firmware 

1 If you are using a laptop, make sure you turn off all power-
saving features and you have a 100% fully charged battery 
before you start the firmware download process. If your 
laptop turns off during the firmware download process, the 
printer may be left in a state that requires being sent to an 
Intermec service office for repair. 

2 Use a null modem cable  to create a serial connection between 
your PC and printer. A parallel connection is not supported. 

3 Make sure the printer is turned on and the null modem cable 
is connected to the PC and the printer. 

4 Insert the SV100 Online Verifier Kit CD into the CD drive 
of your PC. The SV100 Online Verifier Kit window appears. 
Minimize the window. 
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5 Run PrintSet. If you get a communication error, click the 
Auto-Connect button. PrintSet attempts to find the printer. 
PrintSet must find the printer before you can attempt a 
firmware download. If PrintSet cannot find the printer, this 
will need to be resolved before you can download firmware. 

 

Note: If you are using Windows NT 4.0, 2000 or 
XP, make sure that you do not have any other 
application or Windows driver configured for the 
same COM port that the printer is connected to. 
These operating systems do not allow more than one 
device on a COM port at the same time. If you have 
a Windows driver configured for the same COM 
port that the printer is connected to, go into the 
Properties of that driver and change the target port 
to File. This will make the COM port available for 
PrintSet to use. You may have to reboot the PC 
before the COM port becomes available. 

Once PrintSet has successfully connected to the printer, you 
can attempt to download the firmware. 

6 Click DataXfer and select Change Firmware. The Change 
Firmware dialog box appears. 

7 Click the Select Firmware button. 

8 Browse to the Firmware directory on your CD drive. 

9 Decide which firmware upgrade file to use: 

• 200OLVvnnn.exe  Use this file to upgrade the firmware in 
EasyCoder 4420 and 3400e 200 dpi printers. 

• 400OLVvnnn.exe  Use this file to upgrade the firmware in 
EasyCoder 4440 and 3400e 400 dpi printers. 

 

Note: The nnn in the filename indicates the version 
of the firmware release. 

10 Select the file and click Open. 

11 The Change Firmware dialog box displays the current 
firmware version and what version the printer will be changed 
to. Click OK. 
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12 A DOS window opens, and the firmware files unpack on 
their own. If the DOS window does not close after 10 
seconds, manually close it by clicking the X in the upper right 
corner. 

13 A warning box tells you what the current firmware version is 
and what you will be changing it to. Click OK. 

14 PrintSet starts the firmware download. After a few seconds, a 
progress bar appears and shows the firmware download status. 
The whole process should take about 10 minutes. DO NOT 
interrupt the download process. Interrupting the download 
process can cause the printer to no longer turn on correctly 
and it may have to be sent to an Intermec service office to be 
repaired. 

Once the firmware is finished downloading, the printer warm 
boots and the PrintSet main screen appears. 

 

Note: If a communication error dialog box pops up 
right after the firmware finishes upgrading, click the 
Retry button. 

Choosing Reprint Mode or No Reprint Mode 
This section describes the two printer modes: Reprint Mode and 
No Reprint Mode. As you study these descriptions, consider the 
types of bar code print jobs you perform. You may need to select 
a different mode for each new print job. 

Using Reprint Mode 
If a bar code fails while you are using the Reprint Mode, the 
printer voids the failed label and reprints it once. 

Operational overview:  The printer prints the bar code label 
and moves it completely out so that the entire label passes under 
the laser beam. 

If the bar code is verified, the printer retracts the label until the 
printhead is in position to begin printing the next label. (The 
printer retracts each label so that no labels are left blank.) 
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If the bar code fails, LED 1 or LED 2 turns on. The printer 
retracts and voids the failed label, waits for an operator to push 
the Feed/Pause button, and then reprints the label once. If the 
reprinted label also fails, pushing the Feed/Pause button prints 
the next label in the print job. 

The label remains at the tear bar until another label is ready to 
be printed, and then the label retracts. Therefore, if you send 
one label, it does not retract until you send another. If you send 
multiple labels, the printer prints, verifies, retracts, and prints 
the next label until there are no more labels waiting to be 
printed. 

When to use this mode:  Use this mode when you print a batch 
of labels where the data changes for every label, reprints are 
required, and throughput is not important. 

Use this mode when you need the entire printed image to be 
verified. (In No Reprint Mode, the last 17 mm [2/3 in] of the 
printed image does not pass under the scan beam so it cannot be 
verified.) 

If you need the entire printed image to be verified, but you do 
not want failed labels to be reprinted, you can choose Reprint 
Mode and use the Intermec Printer Language (IPL) command 
Media Fault Recovery Mode, Set (<SI>e1) to stop the printer 
from reprinting the failed label. 

Throughput:  Throughput is reduced substantially because 
every label is extended to the tear bar and retracted after being 
printed. 

Limitations:  None. 

Using No Reprint Mode 
If a bar code fails while you are using the No Reprint Mode, the 
printer voids the failed label but does not reprint it. 

Operational overview:  The printer prints the bar code label 
and moves it so that all but the last 17 mm (2/3 in) of the label 
passes under the laser beam. (This allows the printer to continue 
printing the next label without having to retract the printed 
label.) 

If the bar code is verified, the printer begins printing the next 
label or waits for another label to be sent. 
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If the bar code fails, LED 1 or LED 2 turns on. The printer 
retracts the label and voids it. The failed label is not reprinted. 
The printer does not print the next label in the print job until an 
operator presses the Feed/Pause button. 

When to use this mode:  Use this mode when you print a large 
batch of identical labels where throughput is important and 
reprints of a failed label are not necessary. 

Use this mode when you do not need the entire printed image to 
be verified, because in No Reprint Mode the scan stops when 
the last line of the printed image is printed. Therefore, the last 
17 mm (2/3 in) of the printed image is not scanned. For details, 
see page 50. 

Throughput:  The next table shows the minimum bar code 
height required for various print speeds. 

Minimum Bar Code Height (inches) Print Speed (ips) 

0.36 8 

0.25 7 

0.21 6 

0.175 5 

0.15 4 

  

Limitations:  Using No Reprint Mode imposes important 
limitations on your design of bar code labels. For details, see 
page 50. 

Configuring Reprint Mode or No Reprint Mode 
Use PrintSet version 2.51 (or later) to configure the printer for 
Reprint Mode or No Reprint Mode. 

 

Note: You can also configure the mode with the IPL 
command Verifier Mode, Set:  

 <SI>vn   

 where n is 1 for Reprint Mode  
2 for No Reprint Mode 
0 to disable the OLV 
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To configure the printer mode 

1 Run PrintSet. 

2 From the Configuration menu, choose Printer. The Printer 
Configuration dialog box appears.  

3 Click the Options tab. 

  
4 Click Use Reprint Mode to use Reprint Mode.  

Or click Use No Reprint Mode to use No Reprint Mode. 

5 Click OK. 

6 From the File menu, choose Exit. 

7 PrintSet prompts you to save your changes. Click Send to 
Printer. 

Installing ScanVision 
You can load ScanVision from the CD that comes with the 
OLV or from the RJS web site. 

The easiest way to configure your OLV is to use ScanVision. If 
you prefer, you can use the SV100 command language. For a 
description of the commands and how to use them, see the SV 
Series Scanner/Verifier Operator’s Guide. 
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To install ScanVision from the CD 

1 Insert the RJS CD into the CD drive of your PC. The 
ScanVision dialog box appears. 

2 Follow the instructions for installing ScanVision. 

3 Remove the CD from the CD drive. 

To install ScanVision from the web site 

1 Go to the RJS web site at http://www.rjs1.com. 

 

Note: The RJS web site URL contains the letters R, 
J, and S, followed by the number 1. 

2 Click Download Area. 

3 Click ScanVision vx.xx, where x.xx indicates the current 
version of the software available on the site. The compressed 
files download to your PC.  

4 Extract the files. 

5 If Setup does not launch automatically, double-click Setup. 
Follow the directions to install the ScanVision software. 

Sending the Configuration File to the OLV 
The SV100 Online Verifier Kit CD contains a configuration file 
that controls how the OLV operates. You cannot change many 
of the parameters; however, you may need to change the 
parameters that control these characteristics: 

Description Default 

Minimum number of bar codes per label One bar code 

ANSI print grade Disabled 

Minimum number of good scans for a valid read Two good scans 

Picket fence or ladder bar codes Picket fence 
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Note: An OLV purchased through Intermec Product 
Links already contains the correct initial configuration. 
You do not need to send the configuration file to the 
OLV. However, you should continue reading this 
section to determine if you need to create a customized 
configuration file. 

You use ScanVision to send this file to the OLV and to create a 
customized configuration file for each type of print job you 
perform. 

To send the configuration file to the OLV 

1 Insert the SV100 Online Verifier Kit CD into the CD drive 
of your PC. The SV100 Online Verifier Kit window appears. 
Minimize this window. 

2 Run ScanVision. 

3 Press Ctrl-Shift-F5. 

4 If a password is requested, type doorknock and click Close. 
The Verifier Configuration Setup screen appears. The values 
on this screen are the factory defaults for the OLV. Ignore 
these values. 
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5 From the File menu, choose Open.  

6 Browse to the Software directory on your CD drive. 

7 Select the IntermecOLV.cfg file and click the Open button. 
The values in the IntermecOLV.cfg file appear in the fields 
on the Verifier Configuration Setup screen. 

8 Make sure that the Command transmissions for unit 
dependent parameters at the bottom of the screen is set to 
Disable. 

9 Click the Send ALL button. 

10 Click the Permanent button. 

11 Click the Return button. The IntermecOLV.cfg parameters 
have now been sent to the OLV. 

12 Remove the CD from the CD drive. 

To create a customized configuration file 

1 Run ScanVision. 

2 Press Ctrl-Shift-F5. 

3 If a password is requested, type doorknock and click Close. 
The Verifier Configuration Setup screen appears. 

4 Click the Query button to retrieve the OLV’s configuration 
settings. Any values differing between the file on the screen 
and the OLV are marked with a red X. 

5 Enter new parameter settings, as needed. See the table on the 
next page for help. 

6 Make sure Command transmissions for unit dependent 
parameters at the bottom of the screen is set to Disable. 

7 Click the Send ALL button to send the new values to the 
OLV. 

8 Click the Query button to retrieve the OLV’s configuration 
settings. Any values differing between the file on the screen 
and the OLV are marked with a red X. Resolve any 
differences before proceeding. 
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9 From the File menu, choose SaveAs to save these 
configuration settings in a new configuration file. The SaveAs 
Verifier Configuration File dialog box appears. 

10 Specify the name of the new configuration file and click the 
Save button. 

IntermecOLV.cfg Configuration File Parameters 

Parameter Description Settings 

~LN Sets the minimum number of bar codes 
per label.  

The default is 01 (one bar code per 
label). 

01 to 48 for picket 
fence bar codes 

01 for ladder bar 
codes 

~LA Sets the overall passing grade. For 
example, if you set this parameter to 
32, the OLV fails any bar code with an 
ANSI Symbol grade of 3.1 or lower.  

The default is 00 (disabled). 

00 to 40 

~LS Sets the minimum number of good 
scans for a valid read.  

The default is 02 (two scans). 

02 to 99 

~LT Enables or disables partials at the 
decoder level for Interleaved 2 of 5 
codes only.  

The default is 0 (disabled). 

0 = disable 

1 = enable 

~LP Enables or disables partials at the 
decoder level for all symbologies.  

The default is 0 (disabled). 

0 = disable 

1 = enable 

~LV Controls how the OLV uses the LEDs 
to indicate error conditions. Make sure 
this parameter is set to 02. 

The default is 02 (Mode 2). 

02 = Mode 02 

Do not modify 
this parameter. 

~HL Sets the bar code direction to picket 
fence or ladder.  

The default is 0 (picket fence). 

0 = picket fence 

1 = ladder 
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Adjusting and Calibrating the OLV 
You need to perform these tasks when installing the online 
verifier kit for the first time and also when you start a new print 
job with different media or with bar codes printed in a new 
location or orientation: 

• Identify picket fence and ladder bar codes. 

• Position the OLV for picket fence or ladder bar codes. 

• Calibrate the OLV. 

• (Optional) Fine tune your reflectance profile. 

Identifying Picket Fence and Ladder Bar Codes 
You need to identify the orientation of the bar code as it travels 
through the laser beam. You can set up the OLV to read picket 
fence bar codes or ladder bar codes, but not both at the same 
time. 

Feed/Pause

Power/Data
Alert

Empty/Pause

Intermec
Intermec4420

Picket
fence
direction

*WIN*
*WIN*

 
Picket Fence Direction Bar Code 

 

Note: Although this illustration (and the next one) 
show the media cover on the printer, your printer 
should not have the media cover on yet. 
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Ladder Direction Bar Code 

Your next step is to adjust the position of the OLV: 

• To print picket fence bar codes, follow the steps in the next 
section, “Adjusting the Position of the OLV for Picket Fence 
Bar Codes.” 

• To print ladder bar codes, follow the steps in “Adjusting the 
Position of the OLV for Ladder Bar Codes” on page 41. 

Adjusting the Position of the OLV for Picket Fence Bar 
Codes 
To make sure that the OLV scans the picket fence bar codes at 
the correct size and in the correct orientation, you need to use 
the alignment guide, ScanVision, and the calibration bar code as 
described next.  

 

Note: To print ladder bar codes, skip ahead to 
“Adjusting the Position of the OLV for Ladder Bar 
Codes” on page 41. 

To position the OLV for picket fence bar codes 

1 Position the Picket Fence Bar Code Alignment Guide so that 
the slots fit on the cross beams on the right side of the 
horizontal base and the notch fits against the printer tear bar. 
For help, see the callouts on the alignment guide. 

Online Verifier Kit Installation Guide 35 



 

 

Feed/Pause

Power/Data
Alert

Empty/Pause

Intermec
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2 Loosen the T-knob just enough to allow you to adjust the 

OLV so the laser exit window presses against the cutout 
section of the alignment guide, where indicated by the callout 
on the alignment guide.  

3 Adjust the position of the OLV until the laser beam is 
projected onto the printer tear bar. Do not allow the weight 
of the OLV to bend the alignment guide. 

 

Note: If you print self-strip bar codes, the label taken 
sensor is installed on the tear bar. You need to position 
the laser beam in front of the tear bar instead of 
directly on it. 

4 Repeat Steps 1 through 3 with the alignment guide placed at 
the left side of the horizontal base.  

When the laser beam is on the tear bar, you have come close 
to achieving the correct scanning angle of 10 to 34 degrees 
and the correct mounting distance of 20.32 cm (8 in), as 
shown in the next illustration. 
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5 Tighten the T-knob to secure the OLV in place. Do not let 

the OLV move as you tighten the T-knob. 

6 Place the calibration bar code under the laser beam in the 
same position as your bar codes will appear on the label. 
Make sure that the laser beam is still aimed at the tear bar. 
The Read LED lights when the OLV can read the bar code. 

 

Note: You may need to insert the calibration bar code 
under the printhead to make sure that the laser beam is 
on the bar code. Raise the printhead, insert the 
calibration bar code between the printhead and main 
platen, and close the printhead. 

 

Note: If you need to place the calibration bar code to 
the far left, close to the vertical arm, you may need to 
fold the card on which the calibration bar code is 
printed. Make sure to leave enough blank space to the 
left of the bar code for the quiet zone (100 mils or 
about 1/8 in). 
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Note: If you cannot position the laser beam so that it 
appears across the entire calibration bar code, you may 
need to adjust the position of the vertical arm. 

7 Carefully place the media cover back onto the printer.  

 

Note: You may need to adjust the position of the new 
bezel and plate if the plate hits the label taken sensor 
(for self strip) or blocks the path of the laser beam. To 
adjust the position, change the location of the screws 
in the slots in the new bezel and plate. For help, see 
Steps 3 and 4 of the procedure that starts on page 21. 

8 From the Support menu, select Reflectance Profile. Or press 
F3. The Reflectance Profile dialog box appears. 

A good reflectance profile shows a scan with consistent 
amplitude (height), and the amplitude occurs between the 
yellow lines. 

Yellow 
line 

Yellow 
line 

 
Good Reflectance Profile 

A bad reflectance profile shows a scan with amplitude outside 
the yellow lines and having inconsistent values. 
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Note: Make sure the media cover is on the printer. 
The media cover helps reduce the amount of light on 
the bar code label. With too much light, the bottom 
edge of the reflectance profile may appear jagged, as 
shown below. 

 

Yellow 
line 

Yellow 
line 

 
Bad Reflectance Profile 

9 To get a better reflectance profile, perform the steps in “Fine 
Tuning Your Reflectance Profile” on page 46. 

10 Click Return to clear the Reflectance Profile dialog box. 

11 Click the Induce a new bar code analysis button . 
The Bar Code Analysis screen refreshes. 
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The X (mils) parameter contains the X dimension.  
12 Make sure the X dimension shown in the bottom of the Bar 

Code Analysis screen is within ± 0.1 mil of 10 mils, which is 
the size of the calibration bar code. 

• If the X dimension is too large, move the OLV up (away 
from the bar code).  

• If the X dimension is too small, move the OLV down 
(toward the bar code). 

13 Repeat Steps 8 through 12 until the Reflectance Profile and X 
dimension are correct. The OLV is ready to verify labels with 
picket fence bar codes.  

Your next step is to calibrate the OLV, as described in 
“Calibrating the OLV” on page 46. 
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Adjusting the Position of the OLV for Ladder Bar Codes 
To make sure that the OLV scans the ladder bar codes at the 
correct size and in the correct orientation, you need to use the 
alignment guide, ScanVision, and the calibration bar code as 
described next.  

Following this procedure, you also specify the start and stop 
position of the scan. The Ladder Direction Bar Code Alignment 
Guide can help you set the start and stop position relatively close 
to the tear bar. If your print job requires a start and stop 
position further from the tear bar, you may need to adjust the 
position of the OLV without using the alignment guide. 

 

Note: If you are printing picket fence bar codes, do not 
perform these steps. Skip ahead to “Calibrating the 
OLV” on page 46. 

To position the OLV for ladder bar codes 

1 Rotate the OLV 90° so that the laser beam is aimed to strike a 
ladder direction bar code. For help, see the illustration on the 
next page. 

2 Use the Ladder Direction Bar Code Alignment Guide to 
position the OLV. See the callouts on the alignment guide for 
help: 

a Rest the bottom edge on the horizontal base. 

b Place the notch against the tear bar. 

c Align the guide against the side of the OLV that contains 
the laser exit window, along the edge closest to the double 
socket arm. 
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3 Loosen the T-knob just enough to allow you to adjust the 
OLV so that the laser exit window aligns with the cutout edge 
of the guide. 

 

Note: You may need to rotate the RAM mount so 
that the T-knob is 30° down instead of pointing 
straight up. 

4 Tighten the T-knob to secure the OLV in place. Do not let 
the OLV move as you tighten the T-knob. 

5 Carefully replace the media cover on the printer. 

 

Note: You may need to adjust the position of the 
new bezel and plate if the plate hits the label taken 
sensor (for self strip) or blocks the path of the laser 
beam. To adjust the position, change the location of 
the screws in the slots in the new bezel and plate. For 
help, see Steps 3 and 4 of the procedure that starts 
on page 21. 

6 Click the Transmit String button   to open the Transmit 
String dialog box. 
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7 Enter ∼Lp0 and then click Transmit to turn off partial 
decodes. Close the Transmit String dialog box. 

8 From the Advanced menu, select Toggle Additional Results. 
Additional values should now appear on the bottom of the 
screen including Max Gain and Hor Pos. 

9 Place the calibration bar code under the laser beam in the 
same position as your bar code will appear on the label during 
your next print job. Make sure the end of the bar code 
furthest from the tear bar is positioned approximately where 
your bar code will start. This will be the start position of the 
scan. 

 

Note: You may need to insert the calibration bar 
code under the printhead to make sure that the laser 
beam is on the bar code. Raise the printhead, insert 
the calibration bar code between the printhead and 
main platen, and close the printhead. 

 

Note: You can gently crease the calibration bar code 
so that it slopes away from the tear bar parallel to the 
OLV laser exit window. 

10 Click the Induce a new bar code analysis button . 
The Bar Code Analysis screen refreshes. 
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The X (mils) parameter contains the X dimension. 
 

11 Make sure the X dimension shown in the bottom of the Bar 
Code Analysis screen is within ± 0.1 mil of 10 mils, which is 
the size of the calibration bar code. 

• If the X dimension is too large, move the OLV up (away 
from the bar code).  

• If the X dimension is too small, move the OLV down 
(toward the bar code). 

12 Make note of the value shown in the Hor Pos field. This 
value indicates the start position of the scan. 

13 Move the calibration bar code closer to the tear bar. Make 
sure the end of the bar code closest to the tear bar is 
approximately where your bar code will end. This will be the 
stop position of the scan 

14 Click the Induce a new bar code analysis button . 
The Bar Code Analysis screen refreshes. 

15 Make sure the X dimension is still correct, as described in 
Step 11. 

16 Make note of the value shown in the Hor Pos field. This 
value indicates the stop position of the scan. 
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17 From the Setup menu, choose Ladder Mode. The Set to 
Ladder Mode dialog box appears. 

  

18 Click Continue. A dialog box appears telling you ScanVision 
is setting the OLV to Ladder Mode and then the Ladder 
Position dialog box appears. 

  

19 Type the value you noted in Step 12 in the Set the ladder 
Start position field. This should be the smaller of the two 
values you recorded.  

20 Type the value you noted in Step 16 in the Set the ladder 
Stop position field. This should be the larger of the two 
values you recorded. 

21 Click OK. 

22 If you want to enable partial decodes, from the main menu 
select Transmit String, enter ∼Lp1, and then click 
Transmit. Close the Transmit String dialog box. The OLV is 
now ready to scan ladder bar codes. 

Your next step is to calibrate the OLV, as described in the 
next section. 
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Calibrating the OLV 
You need to calibrate the OLV to make sure the scanning 
distance and orientation of your labels is acceptable. 

1 Run ScanVision. 

2 From the Setup menu, select Moving Codes Mode. 

3 From the Setup menu, select Picket Fence Mode. 

4 Make sure the calibration bar code is still under the laser 
beam in the same position that your bar codes will appear on 
the label. 

5 Press and hold the Reset button until the Calibration LED 
begins to flash, and then release the Reset button.  

6 Wait for the laser beam and the Calibration LED to turn off, 
which indicates that the OLV is calibrated. 

7 Remove the calibration bar code.  

8 Press and release the Reset button to turn the laser beam on. 

Fine Tuning Your Reflectance Profile 
If you were unable to achieve a good reflectance profile when 
adjusting the position of the OLV, or if you use flood-coated 
media, you need to follow the instructions in this section.  

Specifically, this section lets you adjust the way ScanVision 
converts the analog input to its digital output. You set a new 
value for gain and offset, which affect the reflectance profile as 
follows: 

• Gain controls the amplitude (height) of the reflectance 
profile. A high value creates a taller profile. 

• Offset controls placement of the reflectance profile on the 
graph. A high value moves the profile lower. 

To adjust the gain and offset 

1 From ScanVision, click the Transmit String button   to 
open the Transmit String dialog box. 

2 Enter ∼HT in the first blank field on the left side of the dialog 
box. 
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3 Click Transmit. ScanVision responds by displaying the 
current OLV parameters on the right side of the dialog box. 

 

The [DACs] line specifies the gain (177) and offset (145). 
 

4 In the screen shown above, locate the line that reads: 

[DACs]= 177 145 255 255 

The 177 is the gain setting and the 145 is the offset setting. 
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5 To change the gain setting, enter ∼Hd101aaa into the next 
blank field, where aaa is the new value for the gain setting: 

• If the reflectance profile does not cover at least six lines on 
the graph, it is not tall enough. The aaa value needs to be 
increased. Try increasing it by 25. In this example, the 
value would go from 177 to 205. The maximum is 225. 

• If the reflectance profile covers more than six lines on the 
graph, it is too tall. The aaa value needs to be decreased. 
Try decreasing it by 25. In this example, the value would 
go from 177 to 152. 

6 To change the offset setting, enter ∼Hd201bbb into the next 
blank field, where bbb is the new value for the offset setting: 

• If the reflectance profile is located above the upper yellow 
line on the graph, it is too high. The bbb value needs to be 
decreased. Try decreasing it by 25. In this example, the 
value would go from 145 to 120. 

• If the reflectance profile is located below the lower yellow 
line on the graph, it is too low. The bbb value needs to be 
increased. Try increasing it by 25. In this example, the 
value would go from 145 to 170. 

7 Press F3 to produce a new reflectance profile and see the 
effect of the new values. 

8 Repeat Steps 3 through 7, changing the gain and offset values 
until the reflectance profile is good. 

9 In the Transmit String dialog box, enter ∼Hx and click 
Transmit to save the new gain and offset settings. The OLV 
will use these new settings when you turn it on. 
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Designing and Printing Bar Code Labels 
When you use the OLV, you need to follow these limitations for 
the design and printing of bar code labels. 

Media Limitations 
For best results with the OLV, print black bar codes onto white 
labels.  Do not use metallic media with the OLV. 

You may achieve acceptable results using flood-coated media 
with the OLV. Using flood-coated media requires additional 
steps during installation, as described in “Fine Tuning Your 
Reflectance Profile” on page 46.  

Minimum Label Length 
If you use Reprint Mode, the minimum label length is 12.7 mm 
(0.5 in). 

If you use No Reprint Mode, the minimum label length is  
25.4 mm (1 in). 

Configuring the Number of Bar Codes Per Label 
You need to configure the OLV with the minimum number of 
bar codes to be verified on each label. This number may need to 
change for each print job you perform. 

To configure this parameter, you can choose one of these 
methods: 

• Using ScanVision, select the Setup menu and choose 
Minimum Codes per Sync to set the number. 

• Using the default IntermecOLV.cfg configuration file, set the 
parameter to one bar code per label. Or create customized 
configuration files that set the parameter to different values. 
For help, see “Sending the Configuration File to the OLV” 
on page 30. 

Maximum Number of Bar Codes Per Label 
If you are printing picket fence direction bar codes, you can fit 
up to four bar codes across (width) and twelve bar codes down 
(length), totaling up to 48 bar codes per label. 
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If you are printing ladder direction bar codes, you can verify one 
bar code on each label. 

No Reprint Mode 
In No Reprint Mode, the start and stop of the OLV scan is 
controlled by the beginning and end of the image being printed, 
not by the beginning and end of the physical label. The OLV 
stops scanning when the last line of the image has been printed.  

In a typical printer, there is approximately 17 mm (2/3 in) of 
space between the OLV scan line and the printhead. That means 
that the last 17 mm (2/3 in) of the printed image does not pass 
under the laser beam, so it is not scanned by the OLV. 

Tear
bar

Printhead
17 mm
(2/3 in)

Laser
beam

 
Setting up the OLV for No Reprint Mode 

When you design a label to be printed in No Reprint Mode, 
make sure that you do not place any bar codes in the last 17 mm 
(2/3 in) of the printed image.  
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Print
Direction

Item 2 of 4
Part Number
073939-001

073939-001

Last line of
image printed

Last line of
image scanned

17 mm (2/3 in)

 
Area Not Scanned: The gray area on the sample bar code label indicates the 
last 17 mm (2/3 in) of the printed image that is not scanned. 

Here are four designs to consider: 

Print
Direction

073939-001

073939-001 17 mm (2/3 in)

 
Design 1: This design is unacceptable because the OLV stops scanning 
before it reaches the bar code. 

073939-001

073939-001

Print
Direction

17 mm (2/3 in)

 
Design 2: This design is acceptable because the dot printed at the trailing 
edge (in the upper right corner) of the label causes the OLV to keep scanning 
until it reaches the last 17 mm  
(2/3 in) of the label. 

 

Note: Remember, the start and stop of the OLV 
scan is controlled by the beginning and end of the 
printed image, not by the beginning and end of the 
physical label. The OLV stops scanning when the 
last line of the image has been printed. 
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Print
Direction

Item 2 of 4
Part Number
073939-001

073939-001

17 mm (2/3 in)

 
Design 3: This design is acceptable because the bar code appears at the 
beginning of the printed image. 

 

 
 
 
 
 
 

PPrree pr-prinintteded
Company logo

073939-001

073939-001

Print
Direction

17 mm (2/3 in)

 
Design 4: This design is acceptable because the dot at the trailing edge 
causes the OLV to keep scanning. The company logo on this label does not 
affect the start or stop of the OLV scan because the logo was pre-printed on 
the media. 

Self-Strip and Batch Takeup 
Be aware of these considerations when using self strip or batch 
takeup with the OLV. 

• If you print self-strip bar codes, the label taken sensor is 
installed on the tear bar. This sensor is in the way of the OLV 
laser beam when you select Reprint Mode, so you need to 
position the beam in front of the tear bar instead of directly 
on it. This affects the design of your bar code labels because 
the entire label will not pass under the beam. Make sure that 
you do not include a bar code that must be verified in the 
space between the scan line and the printhead, where it 
cannot be scanned. 

• If you print ladder direction self strip bar codes, you must 
make sure that the IPL command Label Rest Point, Adjust 
(<SI>fn) is set correctly for the type of media you are using. 
You can use PrintSet to set this command. 

• You cannot use batch takeup when printing ladder direction 
bar codes longer than 11.43 cm (4.5 in). 
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Ladder Direction Bar Codes 
The OLV can verify only one ladder bar code per label.  

The laser beam cannot be aimed so that it strikes both of these 
bar codes. You need to select which bar code you want verified. 
Aim the laser beam onto the one bar code you want verified. 

Print
Direction

3.
0L

X

0
7
3
9
3
9

0
7
3
9
3
9
-
0

 

Reacting to Failed Bar Codes 
When the OLV fails a bar code, LED 1 or LED 2 turns on. The 
printer retracts the failed label, prints VOID VOID VOID 
along the trailing edge, and then waits for operator intervention. 

To clear a voided label 

1 Check the OLV back panel to see if LED 1 or LED 2 is on.  

2 Consult the table on the next page to determine the cause of 
the failure, and perform the recommended solution. 

3 Push the Feed/Pause button to continue: 

• In Reprint Mode, the printer reprints the label once. If the 
reprinted label also fails, push the Feed/Pause button to 
print the next label in the print job. 

• In No Reprint Mode, the printer does not reprint the 
label. Instead, the printer prints the next label in the print 
job or waits for another label to be sent to the printer. 

To receive a status code when the OLV voids a label 

• The <BEL> status code indicates that the OLV has voided a 
label and is waiting for operator intervention. You can use 
IPL commands Status Enquiry (<ENQ>) or Status Dump 
(<VT>) to request status. The printer does not auto-transmit 
the <BEL> status code.  
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Online Verifier Error Conditions and Suggested Solutions 

LED Status Error Condition Solution 

LED 1  
is on 

Quiet zone failure: The quiet 
zone is the white area 
extending on both sides (past 
start and stop) of the bar code. 

Redesign the bar code 
label. For help, see your 
printer user manual. 

 ANSI failure: The bar code 
did not meet ANSI print grade 
requirements.  

Clean the printer as 
described in the printer 
user manual. 

 Contrast failure: The printing 
is too light or too dark. 

For help, see your printer 
user manual. 

LED 2  
is on 

Ribbon wrinkle: Problems 
with the media can cause the 
bar code to fail. 

For help, see your printer 
user manual. 

 Print quality: Problems with 
the print quality can cause the 
bar code to fail. 

For help, see your printer 
user manual. 

 Dot missing: The printhead 
may have a dot missing.  

Perform the ScanVision 
pitch test. If a white line 
appears, there is a dot 
missing. Clean the 
printhead. 

OLV moved: The OLV may 
have been accidentally moved 
from the correct position. 

Adjust and calibrate the 
OLV. 

Either  
LED 1 or 
LED 2  
is on Good Scans too high: The 

Good Scans parameter may be 
set too high for the speed of 
the media and the height of 
the bar codes being scanned. 

Decrease the number of 
good scans by customizing 
the configuration file; for 
help, see page 32. Or use 
the ~LS SV100 command; 
for help, see the SV Series 
Scanner/Verifier Operator’s 
Guide. 

Both  
LED 1 and 
LED 2  
are on 

Configuration file lost: The 
OLV may have lost its 
configuration settings. 

Resend the configuration 
file. For help, see page 31. 
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Specifications 
Physical Specifications 

Package: 112 mm (4.4 in) x 61 mm (2.4 in) x 132 mm (5.2 in) 

Indications: 5 LEDs – Power/Sync, Calibration, Read, LED 1,  
LED 2 

Communications 
Port: 

DB-9 male, RS 232C, programmable baud rate 

I/O Power: DB-15 male, 5 programmable outputs, 2 sync inputs -
+5 VDC @ 1 amp required 

Mounting: 2 sets of mounting holes on 2 different surfaces or a 
clamp for tightening to a 9.5 mm (3/8 in) rod 

  

Environmental Specifications 

Operating 
Temperature: 

4°C to 41°C (40°F to 105°F) 

Storage 
Temperature: 

-20°C to 60°C (-4°F to 140°F) 

Humidity: 10% to 90% non-condensing 

Ambient Light: Not to exceed 0.5 mWatts/sq-mm 600 nm to 700 nm 

  

MTBF Specifications 

10,000 hours (estimated) dominated first by motor life and then by laser life 

  

Laser Scanner Specifications 

Scan rate: 400 scans/second, ± 2 scans/second 

Laser power: 3.0 mW, ± 0.5 mW 

Wavelength: 650 nm to 670 nm 

Beam shape: Elliptical, RJS proprietary design for detection of print 
failure mechanisms 

Class IIIa Laser 
Product: 

See details in the SV Series Scanner/Verifier Operator’s 
Guide 
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